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1 Introducción 

 
En este manual se describen los distintos aspectos que debe conocer el usuario sobre PMD y sobre su 

integración con Eclipse, así como los pasos a seguir para la creación y uso de reglas personalizadas. 
 

2 Conceptos básicos 

 
PMD es una herramienta de auditoría y verificación de código desarrollada por SourceForge. 
 
PMD escanea el código Java y busca posibles problemas en potencia como pueden ser: 
 

¶ Posibles bugs (sentencias try/catch/finally/switch vacias) 

¶ Código muerto (variable locales, parámetros y métodos privados que no se usan) 

¶ Código no óptimo (derroches en el uso de String/StringBuffer) 

¶ Expresiones excesivamente complicadas (sentencias if innecesarias, implementaciones con 
bucles while) 

¶ Código duplicado (código copiar-pegar que significa errores copiados-pegados) 
 
PMD puede instalarse en servidor para ser ejecutado desde tareas ant, o como un plug-in de Eclipse en 

PC local. 
 
Para obtener información adicional sobre el producto acceder a su página Web: 
 

http://pmd.sourceforge.net/ 
 
 

3 Integración con Eclipse 

 
Al igual que en otros muchos casos, la integración del PMD (como plug-in) con Eclipse (o cualquier otro 

IDE de desarrollo) da como resultado un entorno de trabajo visual, sencillo de usar e intuitivo. Gracias a este 
entorno, el manejo de los aspectos de configuración y las distintas funcionalidades del PMD se realiza de forma 
rápida y eficaz. 

 

3.1 Configuración básica 

 
Para poder configurar el plug-in de PMD bajo Eclipse, accedemos al menú ñWindowĄ Preferenceséò  
 

http://pmd.sourceforge.net/
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Una vez hemos accedido a la opción de menú, muestra la siguiente pantalla: 
 

 
 
Se accede al apartado indicado como PMD, pudiendo configurar entonces preferencias generales como 

los parámetros de revisión de violaciones, y las opciones del fichero de Log. 
 
PMD permite crear nuevas reglas, quitar reglas, editar reglas existentes, importar y exportar reglas, y 
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limpiar las existentes. 
 
Antes de proceder a realizar cualquier tarea de importación o de edición de reglas, es aconsejable 

realizar una copia de seguridad de las existentes, para evitar posibles errores o confusiones y así poder 
deshacer cualquier cambio efectuado. 

 

3.1.1. Gestión de las reglas 

 
Añadir una nueva regla 

 
Desde la ventana de preferencias (WindowĄ Preferences...), pulsamos la l²nea ñPMDĄ Rules 

configurationò que permite gestionar las reglas a aplicar a nuestros proyectos. 
 
Existen dos maneras de crear una nueva regla: 

¶ Usando Java. 

¶ Usando una expresión XPath. 
 

1. Pulsar el bot·n ñAdd ruleéò 

 

 

2. Introducir el nombre de la regla, el mensaje, la descripción y el ejemplo. Además: 
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a. En caso de haber creado la regla mediante una clase Java indicar cuál es en el campo Rule 
Implementation Class. 

 
b. En caso de haber creado la regla mediante una expresión XPath activar la casilla de 

verificación XPath rule. En ese caso aparecerá el valor por defecto del campo Rule 
Implementation Class. Y habrá que añadir una propiedad xpath en la que añadir el valor de la 
expresión XPath. 
 

 
 

 
 

Modificar una regla 
 
Desde la ventana de preferencias (WindowĄ Preferences...), pulsamos la l²nea ñPMDĄ Rules 

configurationò que permite gestionar las reglas a aplicar a nuestros proyectos. 
 

1. Seleccionar la regla a modificar. 

2. Pulsar el bot·n ñEdit ruleéò y modificar los campos mensaje, descripción y/o ejemplo. 
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Eliminar una regla 
 
Desde la ventana de preferencias (WindowĄ Preferences...), pulsamos la l²nea ñPMDĄ Rules 

configurationò que permite gestionar las reglas a aplicar a nuestros proyectos. 
 

1. Seleccionar la regla a eliminar. 

2. Pulsar el bot·n ñRemove ruleò. 

 

3.1.2. Exportar reglas 

 
En caso de haber creado nuevas reglas, modificado o eliminado alguna de las existentes existe la 

posibilidad de exportar el conjunto de reglas actual a un nuevo archivo. 
 
Desde la ventana de preferencias (WindowĄ Preferences...), pulsamos la l²nea ñPMDĄ Rules 

configurationò que permite gestionar las reglas a aplicar a nuestros proyectos. 
 

1. Pulsar el bot·n ñExport rule setéò. 

2. Guardar el archivo actual de reglas en una carpeta a determinar por el usuario, y dando un nombre 
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identificativo a dicho archivo para poder recuperarlo a posteriori si se considerase necesario. 
 

3.1.3. Importar reglas 

 
Desde la ventana de preferencias (WindowĄ Preferences...), pulsamos la l²nea ñPMDĄ Rules 

configurationò que permite gestionar las reglas a aplicar a nuestros proyectos. 
 

1. Pulsar sobre el bot·n ñClear allò. Este paso eliminará todas las reglas previamente definidas. Se 
pedirá confirmación de la operación. Si la respuesta es afirmativa, se procederá a la supresión de 
dichas reglas, quedando ahora la pantalla de reglas completamente vacía. 

2. Pulsar sobre el bot·n ñImport rule setéò. Se puede proceder a importar una serie de reglas ya 
disponibles y predefinidas por la herramienta o bien cargarlas desde un fichero XML (suministrado en 
el proceso de instalación de la herramienta). 

 

 

a. Para cargar reglas predefinidas, las seleccionamos desde el desplegable y pulsamos OK, 
realizando este paso tantas veces como conjunto de reglas queramos cargar 

 

 

b. Para cargarlas desde un fichero XML, en nuestro caso el fichero ñPMDconfig.xmlò elaborado 
para EJIE, se deber§ pulsar sobre el bot·n ñBrowseéò y seleccionarlo en el directorio local 
donde tengamos almacenado este fichero. 

 

Salvo casos excepcionales y justificados, deberemos siempre cargar las reglas del fichero PMDconfig.xml 
de Ejie. Se puede descargar junto con la carpeta rulesets, desde el SPS de CAC, en: 

 
http://elkarlan.ejie/webguneak/cac/espacio_compartido/default.aspx?RootFolder=%2fwebguneak
%2fcac%2fespacio%5fcompartido%2fHerramientas%20de%20desarrollo%2fDescargables%2fRe
glas%20PMD&FolderCTID=&View=%7bD4F947E6%2dAC1E%2d4C9D%2dAAB7%2dCB2F7A5E
DF49%7d 

  
Tanto el fichero PMDconfig.xml como la carpeta rulesets descargados, deben ir al mismo directorio. 
 

http://elkarlan.ejie/webguneak/cac/espacio_compartido/default.aspx?RootFolder=%2fwebguneak%2fcac%2fespacio%5fcompartido%2fHerramientas%20de%20desarrollo%2fDescargables%2fReglas%20PMD&FolderCTID=&View=%7bD4F947E6%2dAC1E%2d4C9D%2dAAB7%2dCB2F7A5EDF49%7d
http://elkarlan.ejie/webguneak/cac/espacio_compartido/default.aspx?RootFolder=%2fwebguneak%2fcac%2fespacio%5fcompartido%2fHerramientas%20de%20desarrollo%2fDescargables%2fReglas%20PMD&FolderCTID=&View=%7bD4F947E6%2dAC1E%2d4C9D%2dAAB7%2dCB2F7A5EDF49%7d
http://elkarlan.ejie/webguneak/cac/espacio_compartido/default.aspx?RootFolder=%2fwebguneak%2fcac%2fespacio%5fcompartido%2fHerramientas%20de%20desarrollo%2fDescargables%2fReglas%20PMD&FolderCTID=&View=%7bD4F947E6%2dAC1E%2d4C9D%2dAAB7%2dCB2F7A5EDF49%7d
http://elkarlan.ejie/webguneak/cac/espacio_compartido/default.aspx?RootFolder=%2fwebguneak%2fcac%2fespacio%5fcompartido%2fHerramientas%20de%20desarrollo%2fDescargables%2fReglas%20PMD&FolderCTID=&View=%7bD4F947E6%2dAC1E%2d4C9D%2dAAB7%2dCB2F7A5EDF49%7d
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Veremos como la lista de reglas se ha cargado ya con las seleccionadas. 
 

 
 

3.2 Parametrización de PMD para el proyecto 

 
Para cada proyecto, pueden especificarse diferentes reglas seleccionándolas de las establecidas a nivel 

general. 
 
Para ello, en Eclipse, en la ventana de ñPackage Storeò, se hace un clic derecho de ratón, y se accede al 

apartado de ñPropertiesò. 
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Una vez se ha accedido a este apartado, muestra la siguiente ventana de información: 
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Desde dicha ventana se permitirá: 
 

¶ Habilitar o deshabilitar PMD para el proyecto seleccionado. 

¶ Incluir o no los ficheros derivados. 

¶ Definir los ficheros y subdirectorios que debe analizar PMD (working set) 

¶ Activar o desactivar reglas para este proyecto a través de las casillas de verificación asociadas a 
cada regla. 

 
Salvo causa justificada, se deberán utilizar las reglas del fichero PMDconfig.xml de EJIE en todos los 
proyectos. En el apartado Importar reglas se describe el proceso de carga de estas reglas. 

 
 

3.2.1. Definir ñWorking setò 

 
Un ñworking setò no es m§s que un conjunto de ficheros y subdirectorios de nuestros proyectos Eclipse. 

Para definir un ñworking setò, desde la ventana de propiedades del proyecto (ventana ñPackage Storeò, botón 
derecho, menú ñPropertiesò) se selecciona la línea de configuración de PMD para el proyecto. 

 

1. Pulsar el bot·n ñSelect a working setò  
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Desde dónde podremos seleccionar alguno creado previamente, o bien crear uno nuevo. 

2. Para crear uno nuevo, se pulsará sobre el botón ñNewéò  , el cual nos dará la opción de seleccionar 
los archivos que queremos incorporar: 
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Seleccionamos la opción de Java y pulsamos ñNextò, con lo que deberemos marcar también los ficheros 
de los espacios de trabajo que queremos incorporar, y establecer el nombre que queremos dar al ñworking setò. 

3. Para guardar la selección pulsamos ñFinishò 

 

 
 

4. Marcamos los ñworking setò deseados y pulsamos OK 
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5. Se pueden activar o desactivar las reglas configuradas en el proyecto. Si se activa la casilla ñUse the 
ruleset configured in a Project fileò, esto no será posible y se validarán las reglas definidas en el 
fichero ñ.rulesetò del proyecto. 
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Salvo excepción se deberán utilizar las reglas homologadas en EJIE. En el apartado Importar reglas se 
describe cómo cargar estas reglas. 

 

3.3 Ejecución de PMD 

 
PMD al estar integrado con Eclipse se arranca al lanzar el IDE. El proceso de arranque, es tan simple 

como lanzar el ejecutable del eclipse donde se tenga configurado el plug-in del PMD. Para ello, con el botón 
derecho del ratón, veremos que existe una nueva opción de menú denominada PMD. 
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3.3.1. Generar informes 

 
La opción ñGenerate Reportsò permite obtener informes, creando una carpeta denominada ñreportsò, 

accesible desde la ventana ñPackage Explorerò. Esto genera diferentes tipos de informes consultables sin 
problema alguno por cualquier herramienta, desde un navegador Web, un editor de texto, un visor de archivos 
en formato CSV e incluso en formato XML. 
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Un ejemplo de archivo de informe de salida puede ser el que a continuación se detalla: 
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PMD report 
Problems found 

 

#  File  Line  Problem  

1 src/com/eurohelp/petstore/dao/ItemDao.java  10  
Avoid modifiers which are implied by the 
context  

2 src/com/eurohelp/petstore/dao/Sequence.java  5 
Classes implementing Serial izable should set a 
serialVersionUID  

3 src/com/eurohelp/petstore/dao/Sequence.java  14  Document empty constructor  

4 src/com/eurohelp/petstore/dao/Sequence.java  25  
Parameter 'name' is not assigned and could be 
declared final  

5 src/com/eurohelp/petstore/dao/Sequence.java  28  
Parameter 'nextId' is not assigned and could be 
declared final  

6 src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  18  
Each class should declare at least one 
constructor  

7 src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  20  
Found non - transient, non -sta tic member. 
Please mark as transient or provide accessors.  

8 src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  22  
Parameter 'jdbcTemplate' is not assi gned and 
could be declared final  

9 src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  26  
Parameter 'username' is not assigned and 
could be declared fin al  

10  src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  53  Local variable could be declared final  

11  src/com/eurohelp/petstore/dao/jdbc/AccountDaoImp l.java  53  
StringBuffer constructor is initialized with size 
16, but has at least 494 characters appended  

12  src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  56  
StringBuffer.append is called 32 consecutive 
times with literal Strings. Use a single append 
with a single String.  

13  src/com/eurohelp/petstore/dao/jdbc/AccountDaoImpl.java  78  
The String literal " WHERE " appears 5 times in 
this file; the first occurrence is on line 78  

 
Los resultados se muestran en cuatro columnas: 
 

¶ La primera columna asocia un número incremental a cada uno de los problemas encontrados tras 
realizar la verificación del código de un proyecto (nos permite conocer el número total de 
problemas). 

¶ La segunda (File) muestra la clase para la que se ha detectado el problema (puede haber más de 
un aviso por clase como se muestra en el informe anterior). 

¶ La tercera (Line) muestra el número de línea de código en la que se ha detectado dicho problema. 

¶ La última columna (Problem) muestra la descripción del problema que ha causado el aviso de 
PMD (descripción relacionada con una clase específica dentro de un conjunto concreto de reglas 
de validación habilitado para realizar la verificación del código). 

 

3.3.2. Eliminar incidencias revisadas (Uso de NOPMD) 

 
Existe la posibilidad de acceder a la vista Violations Outline donde se describen los errores encontrados 

para una clase concreta. Seleccionando una descripción podrá marcarse un error como revisado a través de la 
opci·n ñMark as reviewedò lo que generar§ un comentario en la l²nea de c·digo donde se produjo dicho error. 

 

http://pmd.sourceforge.net/rules/controversial.html#UnusedModifier
http://pmd.sourceforge.net/rules/controversial.html#UnusedModifier
http://pmd.sourceforge.net/rules/javabeans.html#MissingSerialVersionUID
http://pmd.sourceforge.net/rules/javabeans.html#MissingSerialVersionUID
http://pmd.sourceforge.net/rules/design.html#UncommentedEmptyConstructor
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/controversial.html#AtLeastOneConstructor
http://pmd.sourceforge.net/rules/controversial.html#AtLeastOneConstructor
http://pmd.sourceforge.net/rules/javabeans.html#BeanMembersShouldSerialize
http://pmd.sourceforge.net/rules/javabeans.html#BeanMembersShouldSerialize
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#MethodArgumentCouldBeFinal
http://pmd.sourceforge.net/rules/optimizations.html#LocalVariableCouldBeFinal
http://pmd.sourceforge.net/rules/strings.html#ConsecutiveLiteralAppends
http://pmd.sourceforge.net/rules/strings.html#ConsecutiveLiteralAppends
http://pmd.sourceforge.net/rules/strings.html#ConsecutiveLiteralAppends
http://pmd.sourceforge.net/rules/strings.html#AvoidDuplicateLiterals
http://pmd.sourceforge.net/rules/strings.html#AvoidDuplicateLiterals
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Sentencia que produjo el error: 
 
while (cartItems.hasNext()) 
 
Sentencia con la marca (comentario) generada: 
 
while (cartItems.hasNext())  // NOPMD by lmgurrea on 3/08/07 12:15 
 
 
NOTA:  En realidad esto sólo se debe utilizar para falsos positivos que pueda devolver PMD. Además hay 

que indicar un motivo por el cu§l se ómarca como revisadoô a la dcha. del nombre de un responsable y la fecha. 
En lugar de utilizar la opción marked as review, es mejor utilizar un template de MyEclipse del tipo: 

 
//NOPMD @responsable=${user} @fecha=${date} @motivo=${curso r}  

 
Resulta útil hacer un template en: 

Window>Preferences>Java>Editor>Templates 
Con nombre NOPMD 

 
De forma que cuando escribamos a la derecha de la línea de código que dé el falso positivo óNOPMDô y 

pulsemos ctrl.+ space se nos escribirá automáticamente lo siguiente: 
 
//NOPMD @responsable=ôUsuario responsableô @fecha=ôFechaô @motivo=  

 

Y el cursor se nos quedará detrás de ómotivo=ô, listo para indicar la razón del uso de NOPMD. Siempre 
hay que indicar el motivo por el cual no vamos a tener en consideración ese aviso de PMD. 

 
 
La opci·n ñClear Violations Reviewsò, permite la supresión de las marcas creadas para las incidencias 

ya revisadas. Por lo tanto eliminará los comentarios añadidos anteriormente. 
 

3.3.3. Buscar código redundante (CPD) 

 
La opci·n ñFind Suspect Cut And Pasteò permite la ejecución del plug-in CPD, para la búsqueda de 

código redundante en el proyecto. Genera un informe, que se ubicará dentro de la carpeta ñreportsò, pudiendo 
ser éste un ejemplo de salida: 

 

 
====================================== ===============================  

Found a 26 line (250 tokens) duplication in the following files:  

Starting at line 337 of 

C: \ Proyectos \ s61Workspace \ PetStoreWar \ src \ com\ eurohelp \ petstore \ dao \ jdbc \ OrderDaoImpl.java  
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Starting at line 430 of 

C: \ Proyectos \ s61Wor kspace \ PetStoreWar \ src \ com\ eurohelp \ petstore \ dao \ jdbc \ OrderDaoImpl.java  

     order = new Order();  

      

     order.setBillAddress1(rs.getString("billaddr1"));  

     order.setBillAddress2(rs.getString("billaddr2"));  

     order.setBillCity(rs.getString("billc ity"));  

     order.setBillCountry(rs.getString("billcountry"));  

     order.setBillState(rs.getString("billstate"));  

     order.setBillToFirstName(rs.getString("billtofirstname"));  

     order.setBillToLastName(rs.getString("billtolastname"));  

     order.set BillZip(rs.getString("billzip"));  

     order.setShipAddress1(rs.getString("shipaddr1"));  

     order.setShipAddress2(rs.getString("shipaddr2"));  

     order.setShipCity(rs.getString("shipcity"));  

     order.setShipCountry(rs.getString("shipcountry"));  

     order.setShipState(rs.getString("shipstate"));  

     order.setShipToFirstName(rs.getString("shiptofirstname"));  

     order.setShipToLastName(rs.getString("shiptolastname"));  

     order.setShipZip(rs.getString("shipzip"));  

     order.setCardType(rs.getString( "cardtype"));  

     order.setCourier(rs.getString("courier"));  

     order.setCreditCard(rs.getString("creditcard"));  

     order.setExpiryDate(rs.getString("exprdate"));  

     order.setLocale(rs.getString("locale"));  

     order.setOrderDate(rs.getDate("orderd ate"));  

      

     order.setTotalPrice(rs.getDouble("totalprice"));  

=====================================================================  

 
El informe generado muestra el código que aparece duplicado (puede estar duplicado dentro de la misma 

clase o en varias clases distintas) e indica la clase a la que pertenece dicho código duplicado y a partir de la línea 
en la que aparece. En este caso concreto el código que se repite (26 líneas) reside en la misma clase y está 
implementado a partir de la línea 337 y duplicado a partir de la línea 430 o viceversa. 

 

3.3.4. Eliminar incidencias 

 
Las incidencias que detecta PMD aparecen reflejadas en la vista ñViolations Overviewò: 
 

 
 
La opci·n ñClear PMD Violationsò, permite limpiar la lista de incidencias de dicha vista: 
 

 
 

3.3.5. Chequear código 
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La opci·n ñCheck Code with PMDò, permite revisar el c·digo bajo PMD, permitiendo incluso que dicho 
chequeo pueda efectuarse en modo Background y poder seguir trabajando sin la necesidad de esperar a que 
dicho chequeo finalice. 
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4 Utilidad práctica 

 
PMD proporciona un amplio conjunto de reglas de verificación de código en base a una serie de pautas 

para la aplicación de buenas técnicas de implementación. Normalmente será suficiente con los conjuntos de 
reglas aportados por la propia herramienta pero existe la posibilidad de creación de reglas de validación 
personalizadas. 

 

4.1 Aportaciones de PMD 

 
A continuación se muestra el listado de los conjuntos de reglas aportadas por PMD así como una breve 

descripción de su utilidad. Cada uno de estos conjuntos incluye una colección de clases que realizan las 
verificaciones específicas. Los enlaces aportados muestran la funcionalidad concreta de cada una de estas 
clases: 

 

¶ Basic JSF rules: Conjunto de reglas con pautas básicas de JSF. 

¶ Basic JSP rules: Conjunto de reglas con pautas básicas de JSP. 

¶ Basic Rules: Colección de buenas prácticas que todo el mundo debería seguir. 

¶ Braces Rules: Colección de reglas para el uso de llaves. 

¶ Clone Implementation Rules: Conjunto de reglas para encontrar usos cuestionables del método 
clone(). 

¶ Code Size Rules: Reglas relacionadas con el tamaño del código. 

¶ Controversial Rules: Conjunto de reglas que pueden ser consideradas, de alguna manera, 
controvertidas. Por ello se han agrupado en esta división. 

¶ Coupling Rules: Conjuntos de reglas que buscan instancias de uniones inapropiadas entre objetos 
y paquetes. 

¶ Design Rules: Reglas que buscan diseños cuestionables. 

¶ Finalizer Rules: Conjunto de reglas para encontrar usos cuestionables del método finalize(). 

¶ Import Statement Rules: Reglas que buscan problemas con las sentencias import. 

¶ J2EE Rules: Reglas para J2EE. 

¶ JavaBean Rules: Conjunto de reglas para JavaBeans. 

¶ JUnit Rules: Reglas que buscan errores que pueden producirse en los testes de JUnit. 

¶ Jakarta Commons Logging Rules: Contiene un conjunto de reglas que busca usos cuestionables 
de este framework. 

¶ Java Logging Rules: Reglas que buscan usos cuestionables de Log. 

¶ Migration Rules: Contienen reglas para la migración de una versión de JDK a otra. Es necesario 
usar los conjuntos de reglas específicos para tales fines que se describen a continuación. 

¶ Migration13: Reglas para la migración a JDK 1.3. 

¶ Migration14: Reglas para la migración a JDK 1.4. 

¶ Migration15: Reglas para la migración a JDK 1.5. 

¶ MigratingToJava4: Reglas para la migración a JDK 1.5. 

¶ Naming Rules: Colección de reglas sobre el uso de nombres (demasiado cortos, demasiado 
largos, etc.). 

¶ Optimization Rules: Reglas para asegurar un mayor rendimiento. 

¶ Strict Exception Rules: Proporcionan pautas estrictas para la propagación y recogida de 
excepciones. 

¶ String and StringBuffer Rules: Reglas que tratan diversos que pueden aparecer a la hora de 
utilizar las clases String o StringBuffer. 

¶ Security Code Guidelines: Estas reglas comprueban las pautas de seguridad aportadas por Sun y 

http://pmd.sourceforge.net/rules/index.html#Basic_JSF_rules
http://pmd.sourceforge.net/rules/index.html#Basic_JSP_rules
http://pmd.sourceforge.net/rules/index.html#Basic_Rules
http://pmd.sourceforge.net/rules/index.html#Braces_Rules
http://pmd.sourceforge.net/rules/index.html#Clone_Implementation_Rules
http://pmd.sourceforge.net/rules/index.html#Code_Size_Rules
http://pmd.sourceforge.net/rules/index.html#Controversial_Rules
http://pmd.sourceforge.net/rules/index.html#Coupling_Rules
http://pmd.sourceforge.net/rules/index.html#Design_Rules
http://pmd.sourceforge.net/rules/index.html#Finalizer_Rules
http://pmd.sourceforge.net/rules/index.html#Import_Statement_Rules
http://pmd.sourceforge.net/rules/index.html#J2EE_Rules
http://pmd.sourceforge.net/rules/index.html#JavaBean_Rules
http://pmd.sourceforge.net/rules/index.html#JUnit_Rules
http://pmd.sourceforge.net/rules/index.html#Jakarta_Commons_Logging_Rules
http://pmd.sourceforge.net/rules/index.html#Java_Logging_Rules
http://pmd.sourceforge.net/rules/index.html#Migration_Rules
http://pmd.sourceforge.net/rules/index.html#Migration13
http://pmd.sourceforge.net/rules/index.html#Migration14
http://pmd.sourceforge.net/rules/index.html#Migration15
http://pmd.sourceforge.net/rules/index.html#MigratingToJava4
http://pmd.sourceforge.net/rules/index.html#Naming_Rules
http://pmd.sourceforge.net/rules/index.html#Optimization_Rules
http://pmd.sourceforge.net/rules/index.html#Strict_Exception_Rules
http://pmd.sourceforge.net/rules/index.html#String_and_StringBuffer_Rules
http://pmd.sourceforge.net/rules/index.html#Security_Code_Guidelines
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publicadas en http://java.sun.com/security/seccodeguide.html#gcg. 

¶ Type Resolution Rules: Conjunto de reglas que verifican el uso de tipos de datos apropiados en 
cada caso, etc. 

¶ Unused Code Rules: Reglas para encontrar código no utilizado (variables locales, métodos 
privados, etc.). 

 
 

4.2 Aportaciones personalizadas 

 
A pesar de que los conjuntos de reglas de verificación aportados son extensos siempre existe la 

posibilidad de modificar el funcionamiento de ciertas reglas de validación para ajustarlas a unas necesidades 
concretas o bien crear nuevas reglas. 

 
Por ejemplo, puede resultar interesante: 
 

¶ Comprobar si se han creado objetos de tipo Thread a través de instrucciones Thread t = new 
Thread();. 

 

¶ Prevenir la probabilidad de encontrar conexiones no cerradas tras comprobar la existencia de 
objetos de tipo Connection. 

 

¶ Prevenir ante el uso de objetos del tipo PrintStrackTrace. 
 

¶ Evitar el uso de expresiones regulares en la implementación de las clases para facilitar su 
posterior mantenimiento. 

 

¶ Evitar el uso de instrucciones que pueden llegar a complicar su legibilidad como en el caso de la 
expresión condicional if (expresion Boolean ? operación verdadera : operación falsa). 

 

¶ Etc. 
 
Los siguientes apartados muestran los pasos a seguir para crear una regla de validación personalizada y 

su, más que probable, posterior uso desde Eclipse. 
 

4.3 Creación de reglas de validación personalizadas 

 
Es necesario explicar brevemente cómo funciona PMD. PMD no analiza el código fuente de manera 

directa. PMD ñparseaò dicho código para generar un elemento AST (Abstract Syntax Tree). 
 
PMD (http://pmd.sourceforge.net/) nos ofrece una herramienta para transformar código fuente en un 

elemento AST. En primer lugar, descargamos y descomprimimos el archivo pmd-bin-4.0.zip. Se nos creará la 
siguiente estructura de directorios: 

 

 
 
Para acceder a dicha herramienta se ejecutará el archivo designer.bat, el cual se encuentra dentro del 

directorio bin. El aspecto que presenta esta herramienta es el siguiente: 

http://java.sun.com/security/seccodeguide.html#gcg
http://pmd.sourceforge.net/rules/index.html#Type_Resolution_Rules
http://pmd.sourceforge.net/rules/index.html#Unused_Code_Rules
http://pmd.sourceforge.net/
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Como un ejemplo sencillo de regla personalizada se creará una regla que detecte los bucles while que no 

rodeen su contenido con llaves ñ{}ò. 
 
En primer lugar vamos a ver la representación AST de un código incorrecto para, posteriormente, 

compararlo con la representación AST del código fuente correcto, es decir, utilizando las llaves ñ{}ò. Para ello: 
 
1. Se introducirá el siguiente código fuente en el área superior izquierda de la herramienta designer.bat: 
 
class Example { 
    void bar() { 
        while (baz) 
            buz.doSomething(); 
    } 
} 
 
2. Se seleccionará el JDK adecuado desde la opción correspondiente de la barra de herramientas: 
 

 
 
3. Se pulsará el botón ñGoò obteniendo así en la pestaña Abstract Syntax Tree / XPath el elemento AST 

correspondiente: 
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Por tanto, como se puede observar, el código del elemento AST de este código fuente será el siguiente: 
 
CompilationUnit 
 TypeDeclaration 
  ClassOrInterfaceDeclaration(Example)(class) 
   ClassOrInterfaceBody 
    ClassOrInterfaceBodyDeclaration 
     MethodDeclaration:(package private) 
      ResultType 
      MethodDeclarator:bar 
       FormalParameters 
      Block 
       BlockStatement 
        Statement 
         WhileStatement 
          Expression 
           PrimaryExpression 
            PrimaryPrefix 
             Name:baz 
          Statement 
           StatementExpression 
            PrimaryExpression 
             PrimaryPrefix 
              Name:buz.doSomething 
             PrimarySuffix 
              Arguments 
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Nos interesa el código del elemento AST relacionado, concretamente, con el bucle while: 
 
         WhileStatement 
          Expression 
 
          Statement 
           StatementExpression 
 
Ahora vemos la representación AST de un código correcto. Para ello ejecutamos el nuevo código con la 

herramienta designer.bat. Podemos observar que ahora s² se han incluido las llaves ñ{}ò rodeando el c·digo 
contenido en el bucle while: 

 
class Example { 
    void bar() { 
        while (baz) { 
            buz.doSomething(); 
        } 
    } 
} 
 
El elemento AST obtenido es: 
 
CompilationUnit 
 TypeDeclaration 
  ClassOrInterfaceDeclaration(Example)(class) 
   ClassOrInterfaceBody 
    ClassOrInterfaceBodyDeclaration 
     MethodDeclaration:(package private) 
      ResultType 
      MethodDeclarator:bar 
       FormalParameters 
      Block 
       BlockStatement 
        Statement 
         WhileStatement 
          Expression 
           PrimaryExpression 
            PrimaryPrefix 
             Name:baz 
          Statement 
           Block 
            BlockStatement 
             Statement 
              StatementExpression 
               PrimaryExpression 
                PrimaryPrefix 
                 Name:buz.doSomething 
                PrimarySuffix 
                 Arguments 
 
Y el código del elemento AST relacionado con el bucle while: 
 
         WhileStatement 
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          Expression 
           
          Statement 
           Block 
            BlockStatement 
             Statement 
              StatementExpression 
 
De esta manera y según nuestro ejemplo, para que un bucle while sea considerado correcto, en la 

transformación de su código fuente a un elemento AST se deberá obtener un elemento WhileStatement que 
contenga un elemento Statement. Y dentro de éste, a su vez, se deberá encontrar un elemento Block (el cual 
hace referencia a un bloque de c·digo contenido entre llaves ñ{}ò que es lo que se desea comprobar). 

 
Como ya se ha visto, existen dos maneras de crear una nueva regla: 
 

¶ Usando Java. 

¶ Usando una expresión XPath. 
 
 

4.3.1. Implementación de una regla personalizada a través de una clase Java 

 
Se deberán seguir los siguientes pasos: 
 
1. En primer lugar se implementará la clase que contiene la regla de validación: 
 
import net.sourceforge.pmd.*; 
import net.sourceforge.pmd.ast.*; 
 
public class DetectarBucleIncorrecto extends AbstractRule { 
    public Object visit(ASTWhileStatement node, Object data) { 
        SimpleNode firstStmt = (SimpleNode)node.jjtGetChild(1); 
        if ( !hasBlockAsFirstChild(firstStmt) ) { 
            addViolation(data, node); 
        } 
        return super.visit(node,data); 
    } 
    private boolean hasBlockAsFirstChild(SimpleNode node) { 
        return ( node.jjtGetNumChildren() != 0 && (node.jjtGetChild(0) instanceof ASTBlock) ); 
    } 
 } 
 
Se puede observar que la clase DetectarBucleIncorrecto implementada hereda de la clase AbstractRule. 

El método visit será llamado cuando se encuentre un elemento ASTWhileStatement. 
 
La siguiente instrucción recoge el segundo hijo del elemento ASTWhileStatement: 
 
SimpleNode firstStmt = (SimpleNode)node.jjtGetChild(1); 
 
Y se comprueba si este nodo, a su vez, tiene o no como primer hijo un elemento de tipo ASTBlock: 
 
return ( node.jjtGetNumChildren() != 0 && (node.jjtGetChild(0) instanceof ASTBlock) ); 
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En caso negativo, se producirá una violación de la regla considerada: 
 
addViolation(data, node); 
 
2. Una vez implementada la clase, necesitamos añadir esta regla a un archivo XML de definición de un 

conjunto de reglas, por ejemplo mycustomrules.xml. 
 
La regla creada deberá presentar los siguientes elementos y atributos: 
 

¶ name: el nombre elegido para reconocer la regla. 

¶ message: el mensaje que debe mostrar la regla cuando se detecte una violación. 

¶ class: la clase que contiene la regla de validación, puede estar en cualquier sitio. 

¶ description: la descripción de la regla. 

¶ example: un pequeño código que muestre un ejemplo de violación de la regla. 
 
Nos puede servir de ayuda, para crear la regla, la opción de menú Create rule XML incluida en la 

herramienta designer.bat: 
 

 
 
Introduciendo el nombre de la regla, el mensaje y la descripci·n y pulsando sobre el bot·n ñCreate rule 

XMLò nos mostrar§ el esqueleto del elemento rule a introducir en el archivo XML de definición del conjunto de 
reglas. 

 

 
 
Será necesario añadir la clase que contiene la regla de validación dentro del elemento class y modificar el 
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ejemplo para que corresponda con uno que viole la regla que está siendo definida. 
 
El archivo XML de definición del conjunto de reglas, incorporando únicamente esta regla, puede presentar 

el siguiente aspecto: 
 
<?xml version="1.0"?> 
<ruleset name="My custom rules" 
    xmlns="http://pmd.sf.net/ruleset/1.0.0" 
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
    xsi:schemaLocation="http://pmd.sf.net/ruleset/1.0.0 http://pmd.sf.net/ruleset_xml_schema.xsd" 
    xsi:noNamespaceSchemaLocation="http://pmd.sf.net/ruleset_xml_schema.xsd"> 
    <rule name="DetectarBuclesWhileSinLLaves" 
    message="Evita utilizar expresiones while sin llaves" 
    class="DetectarBucleIncorrecto"> 
      <description> 
      Evita utilizar expresiones while sin llaves 
      </description> 
 
      <priority>3</priority> 
 
      <example> 
<![CDATA[ 
    public void doSomething() { 
      while (true) 
        x++; 
    } 
]]> 
      </example> 
    </rule> 
</ruleset> 
 

4.3.2. Implementación de una regla personalizada con una expresión XPath 

 
La instrucción xpath que define la regla que estamos implementando es el siguiente: 
 
//WhileStatement[not(Statement/Block)] 
 
Este tipo de implementación también se basa en el código AST generado. Pero en este caso, no es 

necesaria implementar una clase Java. 
 
Pero, como en el caso anterior, sí es necesario añadir esta regla a un archivo XML de definición de un 

conjunto de reglas (mycustomrules.xml) añadiendo un elemento property de nombre xpath cuyo valor sea la 
instrucción xpath que hemos definido antes y modificando el atributo class con el valor de una clase de la 
distribución de PMD net.sourceforge.pmd.rules.XPathRule. 

 
<?xml version="1.0"?> 
<ruleset name="My custom rules" 
    xmlns="http://pmd.sf.net/ruleset/1.0.0" 
    xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" 
    xsi:schemaLocation="http://pmd.sf.net/ruleset/1.0.0 http://pmd.sf.net/ruleset_xml_schema.xsd" 
    xsi:noNamespaceSchemaLocation="http://pmd.sf.net/ruleset_xml_schema.xsd"> 
    <rule name="DetectarBuclesWhileSinLLavesXPath" 
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    message="Evita utilizar expresiones while sin llaves" 
    class="net.sourceforge.pmd.rules.XPathRule"> 
      <description> 
      Evita utilizar expresiones while sin llaves 
      </description> 
 
      <priority>3</priority> 
 
      <properties> 
        <property name="xpath"> 
         <value> 
         //WhileStatement[not(Statement/Block)] 
         </value> 
       </property> 
     </properties> 
 
      <example> 
<![CDATA[ 
    public void doSomething() { 
      while (true) 
        x++; 
    } 
]]> 
      </example> 
    </rule> 
</ruleset> 
 

4.3.3. Cómo usar un conjunto de reglas personalizadas con Eclipse 

 
PMD busca los archivos de conjuntos de reglas en el classpath definido para el plug-in. Por tanto, para 

usar un conjunto de reglas personalizadas, deberán estar situadas en el classpath del plug-in PMD. 
 
La manera de hacer esto con Eclipse es empaquetar los conjuntos de reglas en un fragmento del plug-in. 

Un fragmento es una extensión del plug-in y todas las clases y los archivos de recursos que contenga son 
automáticamente añadidos al classpath principal del plug-in. 

 
Los pasos para añadir un conjunto de reglas personalizado son los siguientes: 
 

1. Crear un fragmento de Plug-in fragment como una extensión del plug-in PMD. 
2. Implementar las reglas. 
3. Crear uno o más conjuntos de reglas. 
4. Empaquetar el fragmento. 
5. Instalar el fragmento. 

 
Crear un fragmento de plug-in como una extensión del plug-in PMD 
 
El primer paso es configurar el entorno de desarollo del plug-in. Para ello nos dirigimos a Window >> 

Preferences >> Plug-in development >> Target platform y pulsamos el bot·n ñSelect Allò y a continuaci·n el 
bot·n ñOKò para cerrar la ventana. 

 
El segundo paso el crear el proyecto para el fragmento: 
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Elegimos la opción del menú File >> New Projecté y seleccionamos dentro de la categoría Plug-in 
development el elemento Fragment Project. A continuaci·n, pulsamos el bot·n ñNextò. 

 
Damos un nombre al proyecto (un nombre de un proyecto Plug-in normalmente se escribe como el 

nombre de un paquete, por ejemplo com.foo.pmd.rules). 
 
En la siguiente ventana seleccionamos el Fragment ID, por defecto el mismo nombre del proyecto. 

También seleccionamos el Plug-in ID el cual debe hacer referencia al ID de un plug-in existente para el 
workspace, en nuestro caso net.sourceforge.pmd.core. 

 

 
 
Una vez creado un proyecto Plug-in Fragment la estructura obtenida será similar a la siguiente: 
 

 
 
Implementar las reglas 
 
Ya hemos visto en un apartado anterior cómo implementar reglas personalizadas. Vamos a hacer uso en 
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este ejemplo de la clase anteriormente implementada DetectarBucleIncorrecto.java. Simplemente es necesario 
indicar que ésta u otras clases implementadas deberán colocarse en el directorio src. 

 
Crear uno o más conjuntos de reglas 
 
También hemos visto anteriormente este apartado, por tanto sólo indicar que se deberá colocar el archivo 

XML de definición de un conjunto de reglas, en este caso el que ya hemos utilizado mycustomrules.xml en el 
directorio source (src). 

 

 
 
Empaquetar el fragmento 
 
También será necesario, antes de desplegar el fragmento, empaquetarlo. Para ello exportaremos el 

proyecto con la opción Exporté a la que accederemos situándonos sobre el proyecto Plug-in Fragment creado y 
pulsando el botón derecho del ratón. Tras esto, seleccionaremos Deployable plug-ins and fragments. El 
siguiente paso será seleccionar el plug-in para el que se realiza la extensión y se especificará el directorio de 
destino. 
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Podremos observar que se nos habrá creado en el directorio de destino una nueva carpeta plugins en la 

que aparecerá el archivo .jar creado, en nuestro caso com.pruebas.pmd.rules_1.0.0.jar. 
 

 
 
 
Instalar el fragmento 
 
Para instalar el fragmento descomprimiremos la distribución del paquete en el directorio plug-ins del 

Eclipse y lo reiniciaremos. 
 

 
 
Sólo queda, entonces, activar el conjunto de reglas personalizadas y para ello, como ya hemos visto, 

abriremos Window >> Preferences y seleccionaremos Rules configuration dentro de la categoría PMD. 
Pulsaremos sobre el bot·n ñImport rule setéò y seleccionaremos el archivo XML de definici·n del conjunto de 
reglas creado para el ejemplo. Como ¼ltimo paso pulsaremos sobre el bot·n òOKò. 

 

 
 
Podemos observar cómo aparece la nueva regla creada (DetectarBucleWhileSinLlaves) en la lista de 

reglas. Así, cada vez que PMD realice una validación tendrá en cuenta la nueva regla que hemos introducido. 
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5 Tareas ant en servidor 

 
La validación del código java con PMD también es posible ejecutarla en el servidor como tareas Ant. Así 

se asumen los siguientes acuerdos: 
 

¶ El fichero de configuraci·n de PMD de cada aplicaci·n se denomina ñPMDconfig.xmlò y se 
encuentra en ñ/dominio_wls8/j2se/jakarta-ant-1.5.3-1/rulesò. Va acompañado de la carpeta 
ñrulesetsò. 

 

¶ Los ficheros de salida resultado de la validaci·n ser§n, ñpmd_report.xmlò y ñpmd_report.htmlò, 
en formato xml y html respectivamente, y se ubicarán en 
ñ/aplic/aaa/java/javs/aaaEAR/aaaTestingWar/test/informesò. (Donde aaa es el código de 
aplicación). 

 

¶ La tarea que ejecuta PMD se denomina ñpmdò: 
 

ant pmd 
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6 Anexo 1: Ejemplo 

 
Este ejemplo realiza la verificación del código de s73aPetStoreWar a partir del archivo de reglas 

PMDconfig.xml y muestra los resultados obtenidos a través de un informe HTML. 
 
A continuación se realiza la búsqueda de código redundante (duplicado) y se muestra el informe txt 

generado. 
 

6.1 Resolución 

 
Los primeros 3 pasos sólo son necesarios para trabajar con la interfaz más adecuada para la verificación 

de código por parte de PMD. 
 

1. En caso de no tener abierta la perspectiva que ofrece PMD habrá que seleccionarla desde la 
opción de menú Window > Open Perspective > Otheré 

 

 
 

2. En la nueva ventana aparecida se seleccionará la correspondiente perspectiva de PMD como 
muestra la imagen siguiente. 
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Se trabajará sobre esta perspectiva para poder obtener toda la información relativa a la 
verificación de código que se desee realizar con PMD. 

 

 
 

3. Se seleccionarán las vistas que se estimen oportunas pertenecientes a la perspectiva de PMD. 
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La imagen superior muestra las vistas Violations Outline y Violations Overview. En caso de 
necesitar alguna otra se seleccionará la opción de menú Window > Show View > Otheré Se 
abrirá la siguiente ventana y se escogerán las vistas deseadas. 

 

 
 

4. Es el turno de configurar las reglas a utilizar con PMD. Para ello se selecciona la opción del menú 
principal Window > Preferencesé 

 

 
 


